
stethos
®

 
 
 
 
 
 
 

Enhanced Laser Printing ELP  
 
 
 
 
 

Introduction and Installation Guide 

 
 
 
 
Revision 8.40   © seit 2001 
 
 
For  
 
MS Windows NT based platforms 
Unix, Linux, Solaris, VMS, True64, 
AS/400 and AIX  
As firmware extension for various laser printer 
 



 

www.stethos.com 2

Enhanced Laser Printing 
ELP general information 

Quick Install Guide for Microsoft Windows 
 
1. On a Windows NT, 2000, 2003, XP or Vista system, logon with administrator 

rights and double-click the provided Install.msi file to start the installation 
wizard. 
 
Important notes:  
A) You need to have administrator rights in order to install the software 
B) Network users need to give all users the read permissions to the 
  installation directory, and read/write permissions to the forms directory. 
 
The wizard will guide you through the installation: accept our license 
agreement and choose the appropriate installation directory. 
 

2. After copying the required files and registering, a dos shell will appear for 
some few seconds and disappear if no errors occur. If there are complications, 
the dos prompt will halt and an error message appears. Please report any instal-
lation errors to your distributor, mentioning the message occurred on the 
display.  

3. If no error message appears, the installation successfully finished. By clicking 
the 'Finish' button, the installation application ends. 

4. Now go to 'Start' -> 'Programs' and find the entry 'Enhanced laser printing 
ELP”, where you can select either extensive documentation or the 'PPAdmin 
Control Centre' program.  

5. Start the PPAdmin program and select the Install tab. Select a printer on the left 
side and press the '>>' button to move it to the installed right side. If no printer 
is displayed see page 55H30, how to activate ELP by Hand. 

 
6. Push the 'Mark printer to print demo file' button 

and a list with available demos will appear. 
Choose a form (e.g. BarcodeOverview.pcl) and 
this test form will be sent to the selected printer. 
Now W-ELP Server Print Processor works fine on 
your system.  

 
It is strongly suggested to configure the email software: 
Blat. This will enable the print processor to send out 
notification mails on any detected problems while 
processing print jobs. See later in this manual. 
 



 
Enhanced Laser Printing 

ELP Software support 

Quick test: Printing out Microsoft Word 
 
Load provided example "Invoice" using the Start Menu and print it using a PCL 5e 
or 5c Printer driver.  
 
You may want to generate your own Microsoft Word, using Forms and ELP-
Commands: Create a new empty document, type some sample text ("e.g. 'this is a 
welpprint sample test') and follow these steps to print a test form. 
 
1. First, enable field code to be seen. Go to 'Tools' -> 'Options'; in the 'View' tab, 

enable checkbox 'Field codes'. 
 

2. Go to 'Insert' -> 'Field' and select the 
Print command (Windows 97: 
German Druck) in the left list box 
('Field Names').  
 

3. In the text box below (after 'PRINT'), 
enter: "<<K3;C1:1O500;D1;>>" 
 

4. Now, if you select 'File' -> 'Print', the 
print dialog appears and you must 
select a printer. Be sure to select a 
PCL 5e printer, which has the proces-
sor welpprint configured; otherwise, 
the form won't be applied to the document. 
 

5. The result should be three pages with your sample text combined with a W-ELP 
example form/watermark  
 

6. To create your own form/watermark, just design an appropriate image 
(Photoshop, etc.) or layout (Microsoft Word, etc.) and print it to a file (should 
have the suffix .prn).  
 

7. Open PPAdmin and push the 'Add' button in the 'Macros' tab. A file dialog 
appears and you may select the created .prn file. Give it a number between 
1000 and 32000, for example 1500. Now, it'll appear in the List box as 
1500.mac. 
 

8. Follow steps 2 to 5 and substitute the [..]O500[..] with [..]O1500[..] (your 
generated MAC file): "<<K3;C1:1O1500;D1;>>"; printing it should result in 
the customized form/watermark to be applied. 
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Software License and Copyright 
 
This Software is copyrighted and all rights reserved by the developer, hereinafter 
referred to as " manufacturer ". In return for the payment of an one time license fee 
which was included in the purchase price of the ELP product, manufacturer grants 
you a non-exclusive right to use the Software/Firmware subject to the following 
terms and conditions. No title or ownership of the Software/Firmware is conferred 
with the License. 
 
1) The Software/Firmware may be used without time limit on one PC/printer. 
 
2) The Software/Firmware may not be duplicated or copied. 
 
3) The Software/Firmware may not be duplicated, transmitted, transcribed, 

disassembled, decompiled, decrypted or reverse engineered unless 
manufacturer prior written consent is either obtained or required by law. Upon 
request, the user will provide manufacturer with reasonably detailed 
information regarding any disassembly, de-compilation, decryption or reverse 
engineering. 

 
4) Any third party supplier of the Software/Firmware may protect its rights in the 

Software/Firmware against violation of this License. 
 
5) The manufacturer reserves the right to terminate this License upon breach. In 

the event of a termination, all copies of the Software/Firmware must be 
returned to manufacturer or, with manufacturer prior written consent, a 
certificate of destruction of all copies may be provided to manufacturer. Any 
use of the Software/Firmware in violation of the copyright laws constitutes 
termination of this agreement and prosecution will begin. 

 
6) This License and the Software/Firmware product may be transferred to a third 

party provided the third party agrees to all the terms of this License and that no 
copies of the Software/Firmware are retained by the transferring party. 

 
Software License Agreement 
 
IMPORTANT: Please read this License carefully before using the manufacturer 
Software or Hardware, hereinafter referred to as "SOFTWARE". The right to use 
this Software is granted only if the Customer agrees to the terms of this License. If 
you do not agree to the terms of this License, you may return the unused Software 
product for a refund. HOWEVER, INSTALLATION AND USE OF THIS 
SOFTWARE INDICATES YOUR FULL ACCEPTANCE OF THESE 
TERMS AND CONDITIONS. 
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Contact and support address  
 
Please open the PPAdmin software -> License Tab -> about, or 
start the convert.exe software without any argument. 
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Limited Warranty 
 
To the original purchaser, the manufacturer warrants the data store medium and the 
hardware module (if applicable) like flash memory card or appliance to be free of 
defects in materials and faulty workmanship for a period of ninety (90) days from 
the date the software is delivered. If during this period a defect in the data store 
medium and/or the hardware module should occur, you may return the product with 
a copy of your receipt or other proof of payment to the manufacturer or to an 
authorised distributor, and the manufacturer/distributor will replace it without 
charge. Your sole and exclusive remedy in the event of a defect is expressly limited 
to replacement of the data store medium and/or the hardware module as provided 
above. 
 
The manufacturer does not warrant that the functions contained in this Software will 
meet your requirements or that the Software/Firmware operation will be 
uninterrupted or error free. Information contained in the user manual is subject to 
change without notice and does not represent a commitment on the part of the 
manufacturer. 
 
IN NO EVENT WILL THE MANUFACTURER OR ANYONE ELSE WHO HAS 
BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF 
THIS SOFTWARE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING 
ANY LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY 
TO USE THIS PROGRAM, OR FOR ANY CLAIM BY ANY OTHER PARTY. 
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
PROGRAM AND MANUAL IS ASSUMED BY YOU. 
 
This agreement shall be constructed, interpreted and governed by the laws of 
Germany. You agree that this is the complete and exclusive statements of this 
agreement which supersedes any prior agreement or other communication between 
us on this subject. 
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Introduction 
 
The Enhanced Laser Printing Print Server Processor (ELP) is a software tool based 
mainly upon  PCL 5 and with some restrictions also on Postscript data streams. PCL 
is Hewlett-Packards Printer Command Language which is used by nearly all Laser 
and Business InkJets printer. The ELP implementation does follow as much as 
possible industry standards. The available functions are printing: 
 
• All known 1D barcodes plus the 2D code: PDF 417 and UPS Maxicode in PCL 

and Postscript, as well as Data Matrix in PCL only. 

• A Kyocera Prescribe Emulation for their way of barcode printing 

• Electronic Forms, with de- / encryption of forms and data streams, as well as 
compressing data streams (Decompression and decryption in the printer using 
an ELP Firmware extension stored on a memory flash module. 

• Including reprints with additional forms and paper path settings 

• Accounting, print verification and reporting; Job ticketing 

• Additional Fonts (Unicode), HexEmulation, Epson FX Emulation, PPDS, 
VGL, TIFF, CALS, Prescribe, etc. 

• emailing and faxes, Database researches. 

• Automatic emails and converting into Acrobat™ PDF Format 

• PDF direct printing to Postscript printers, or Postscript to PCL  

• Monitored printing, error recovery and user information 

Intelligent trigger routines enable any product function on demand. In addition, ELP 
also provides a simple way to change or erase any data stream code. 
 
The software can be installed on the following operating systems: 
• MS NT based Windows systems. Because ELP does use only a printer queue, 

the print data can be received from any platform to be sent to any platform.  
• Any Unix or Linux platform handling print files and/or installed as a pipe 

directly in the LPR command using STDIN/OUT methods. 
• AIX and Solaris, usage like Unix 

• AS/400 (with some limitations) 

• VMS   
• DOS or as sources in your application 
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ELP functions overview 
 
Basic ELP functions: 

• Easy generation and activation of macros / forms / logos etc out of print  
files (prn), and insert them on demand in data stream by searching for the 
macro PCL sequences.  

• Search and add/insert or replace any text or any command, in any data 
stream. This functionality can be used for example to insert forms on 
demand.  

• Setting the printer to EconoMode 
• Allow only gray printing on HP colour devices 
• Allow only printing from certain applications etc. 
• Tray mapping 

 
1D Barcode  

• Intelligent barcodes emulation which supports  even more 1D barcodes 
than the JetMobile (TM) BarDIMM. 

• FreeEscape support. 
• OMR support for inserting letters into envelopes, postal optimisation. 
• PCL and Postscript 

 
2D Barcode: PDF417 Barcode, Datamatrix and UPS Maxicode TM 
 
ELP Functions  

• Enabling all ELP commands like reprinting, copy and page definitions etc. 
• Trigger those functions using infile TRIGGER_...keys 
• Report Line Generator 

 
Epson Emulation FX 100 9 Needle 
Proprinter / PPDS Emulation 
VGL Emulation 
PGL Emulation 
IGP10 Emulation  
Prescribe Emulation 

• Those emulations are developed for customers, they are not a 100% 
emulation. But on request and problems we can always add missing 
functions or correct any problem.  

 
TIFF printing and CALS Emulation. 
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PDF Converter 
• Converts on request print files to Adobe Acrobat PDF format and send it to 

the archive or ELP is using SNMT communication to send the data as an 
email to any address.  

• The PCL5/PCL6/TIFF to PDF converter is optional and is licensed per 
server. 

 
email Function  

• Sending fully automatic emails to any address, found in the data stream. If 
the PDF converter is available as PDF attachment. 

• Using trigger functions, you can define any subject and body text, for 
example to differentiate between for example orders or invoices, or 
languages German or English etc. 

 
Fax Function (pretty similar to email.) 
 
PCL Compression 8: Realises the conversion from PCL Compression Mode 8 to 5. 

 
Archiving and MyPrintArchive 

• Sends print files into an archive directory, optional in Adobes PDF format. 
• PPAdmin provides a search and view/email/print function 
• ELP writes an HPS index file, so data can be sent to any global archive 

system with automatic indexing. 
• Uses user defined file names for archiving 
• Reload automatically archived jobs and print and delete them 
• MyPrintArchive stores all jobs from a user/searched item etc. send to a 

specific queue and on demand resend them to any printer   
 

Accounting 
• Records into a text (CSV format) or DBase file all print job, page size, 

from whom, when etc, including collected document information’s like 
check numbers etc.  

• With Monitored printing also the true page counters are stored for real 
print cost calculation. 

 
Monitored printing 

• Send data streams direct to IP connected printers and monitor the print job. 
On printer error send a user notification and start recovery actions. 
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Variable management 
• User name, time, day, week, etc. can be used on any page. 
• External files can be used to search for any place holder, which are 

replaced by the value. 
• ELP can setup its own item counters, as well page counters. 

 
Distributed printing, page 

• Send data stream to different ports, queues or archives. 
Depending upon: Copy factors or file size. 

• Call any other software or communication tool and read back data 
• Split a print job, for example to archive each invoice 
• Send Data to any external software, including own defined command line 

parameters 
 
Symbol set conversion 

• For example to EBCDIC to ASCII. 
 

Unicode and double byte printing 
• Prints Unicode and double byte fonts (e.g. simplified or traditional 

Chinese) on non Unicode or double .byte fonts enabled printers 
 
Miscellaneous  

• Reverse printing.  
• Print colour jobs optional on HP printers only in gray scale.  
• Set toner save mode. 
• Do not print at all, maybe print streams from software the user is not 

allowed to use 
• The data stream is analysed and will be sent to the best fit paper roll. 
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Requirements 
 
Data Stream format:  PCL 5e (HP LaserJet),  

PCL 5C 
Postscript with some limitations 
PCL3GUI (HP Business InkJet) with some limitations 
for accounting all data formats 
PCL 5e or Postscript for Bar-coding 

 
Hardware DIMM:  The DIMM is available for HP LaserJet printer series: 2300, 

4050, 4100, 4200, 4300, 4600, 8100, 8150 and 9000. 
 
Hardware MFC:  The memory flash card is available for HP LaserJet printer 

series: 2400, 4250, 4350, 4650, 5550, 9050, 9040 others on 
request. 

 
Hardware USB:  The memory flash USB sticks available for HP LaserJet 

printer series: P3005, 3505, M5035 and most newer HP 
printers. 

 
Software version: Windows NT, 2000 or XP for Print Processor installation 

Also recommended to be installed for Unix forms 
development and testing. 
 
Software version for Unix, Linux, AIX, VMS or Solaris if 
needed to be installed on those systems. 

 
ELP will only need system performance, when a print job is parsed.  
 
Tests have been made in order to analyse the CPU workload and performance: 
A typical job with 270 Kbytes incoming data, needed to load a Form with 100K, 
generates a barcode and write the process into accounting file needs less then one 
second to be processed. 
 
The same time was needed to pass through a 1.5 MB file without any changes. 
 
 
The demo version 
 
The limitations of the demo version are: 
1. Every Barcode is printed with the word DEMO on 
2. On every PCL5 print page the DEMO watermark is printed 
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3. Before the job is processed, you need to click OK in a demo message box on 
the server, which runs the ELP Software. 
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Installation and testing 
 
This chapter explains  
1. How to install the ELP either as a Hardware DIMM in a HP LaserJet or on the 

various provided operating systems.  
2. At the end of each product chapters, how to test the functionality.  
 
If you have a 
DIMM /MFC Card  continue reading 
Unix/Linux/AIX/VMS continue on page 109H19 
Windows NT/2000/XP continue on page 110H23 
 

Hardware DIMM / MFC / USB Stick / Harddisks for HP LaserJet 
printers 
 
Please read the full chapter up to the end, especially the statement in the key 
ELP_MAX_HEAP influence of the requested printer memory. 
 
Note some functions like Archiving, distributed printing and time functions are not 
supported on the DIMM or MFC (Memory Flash Card) implementation of ELP. In 
order to implement ELP into your environment, it could be a good idea to emulate 
first a DIMM using the Windows or Unix based version. In this case please add to 
the command line the parameter -p7 surrounded by blanks. Or set the DIMM 
MODE option in PPAdmin’s Admin Tab and APPLY the settings. In order to make 
them work, exit PPAdmin and restart it. 
 
Note: In very rare cases, the DIMM may cause problems with bidirectional 
communication between the printer and the host. This does not affect Windows 
printing. Only if the host opens a job tracking communication. 
 
The DIMM / MFC / etc. version does not support the following status read back 
Escape sequences: Esc*s#X, Esc*s#I, Esc*s#U, Esc*s#T, Esc*s#M. The good thing 
about that is, that we have never seen them being used by any type of software. 
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Software Installation 
 
Using the MS Windows file manager, please copy the contend of the Floppy Disk 
into any Directory of your system. You only need PPAdmin if you want to  
• create forms download forms to the module,  
• in order to exchange the ini-file, or 
• to create and test the ini-file(s) before downloading. 
 
Especially for the testing it is recommended to set the ELP functionality of the MS 
Windows version into the DIMM mode. Therefore start PPAdmin, open the 
Administration register and mark the “DIMM Mode”. Click on Apply, exit and 
restart PPadmin. From now on, the windows ELP system will ignore all functions 
which are NOT available in the DIMM version. 
 
Finally we recommend to add the key PCLPreciseMode into the section GLOBAL 
of the ini-file and turn it on. 
 
 
MFC / DIMM / USB Stick Installation 
 
Before you are going to install the module, check for proper version for your 
printer. Each printer version like 4050, 4100 or 9000 does need its own particular 
firmware DIMM. The version is printed on the module and on the shipping box. 
 
Your HP LaserJet has three or four DIMM (Dual Inline Memory Module) slots. 
The module can be installed in any of these slots.  
 
Protecting the SIMM / DIMM Board 
SIMM/DIMM boards can easily be damaged by small amounts of static electricity. 
To remove any static electricity from your body: 
 
Touch the surface of the antistatic package before removing the board from its 
package. When handling the board, frequently touch bare metal on the printer or the 
antistatic bag or wear an antistatic wrist strap. 
 
Avoid moving about the work area to prevent generating static electricity. Handle 
the board carefully at all the times. Avoid flexing it or touching its components. 
When removing a board from the antistatic package, avoid touching the metal 
traces on the SIMM/DIMM board. Hazardous voltages are present in the printer. 
Never remove any access cover or work near exposed electrical parts while the 
power cord is connected. 
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The ELP DIMM board has to be installed exactly like a RAM board. Please follow 
the SIMM/DIMM module installation procedure detailed in the HP Printers User's 
Manual. 
The DIMM / MFC etc. is a PCL firmware. Therefore it can not be installed in the 
printer together with another PCL personality as a conflict would then occur. Such 
PCL personalities like E-Form or secured MICR products. 
 
 
Update the DIMM / MFC / Stick module 
 
Simply copy the provided file to the printer: 
 
MS Windows based systems: 
A printer directly connected to the PC:   

copy /b UpdateFileName.ext lpt1 
 
Using a windows printer queue:   

copy /b FileName.ext \\ServerName\PrinterRelaseName 
The server name can be found using PPAdmin’s licence tab.  
The PrinterReleaseName is displayed in the printer properties, tab release. 

 
Using the FTP file transfer for network connected printers. In MS DOS command 
prompt type: 

FTP connect IP-addressOfPrinter 
binary 
put FullPathAndNameOf UpdateFile.ext 
bye 
 

Using the LPR command 
LPR –S IP-Address –P PrinterQueueName –o UpdateFilename 

 
UNIX bases systems: Use the LP command:  
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Test the module 
 
Besides sending one of our demo files to the printer, there is a quick way to check 
the functionality of the DIMM, the printer’s configuration page.  
 
1. Select the configurations menu 
2. Select the configuration page 
3. Press select 
 
At the middle of the first page, the “Installed Personalities and Options“ are listed. 
The product is working when an IOF entry is listed, which displays the ELP 
version. 
IOF 254(-): ELP(active) (datecode) Version © 1999-2008…. 
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You may also open the new HP printers web page and will find the same line at the 
configuration page. 
 
For the second test method, send one of the provided demo files to the printer. See 
page 38 for the file description, and the previous page chapter for the methods to 
send the files to the printer. 
 
 
Echo-ing the printer and get ELP version back. (Version 8.26) 
 
The activated filter does parse all incoming data streams. In oder to get the 
information back from the printer, maybe using any distribution tool, send the 
following data stream to the printer:  
 
esc%-12345X@PJL ECHO Get ELP Version 
esc%-12345X 
 
The activated ELP does change that request in a  way, that the printer will return 
ECHO ELP Vx.x.  
Meaning if the original ECHO Argument comes back from the printer, no ELP is 
active or installed. If the printer returns ECHO ELP V… you even have then the 
ELP version running on the printer or in the box. 
 
 
LaserJet initialisation or automatic data stream 
 
Most newer ELP firmware extension modules for HP LaserJets do have the ability 
to send every time the printer boots a file to the print engine, just once. For that 
purpose any print file called  PrinterInit.prn can be stored into the 0:\convert 
directory or into the first directory ELP will find at boot on a convert.ini file on 
volume 0 to 5. 
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Special Ini-File keys: 
 
The following 2 keys are only valid in the LaserJet Implementation. 
 
Ini-File Key Description 
LJ_PARSE_PCL6 
 

Key only used by HP’s ELP Printer firmwasre 
extention in DIMM/MFC/USB/SD/Harddisk version 
to parse also PCL XL data streams 

LJ_PARSE_Postscript  
 

Key only used by HP’s ELP Printer firmwasre 
extention in DIMM/MFC/USB/SD/Harddisk version 
to parse also Postscript data streams 

LJ_Mode_TimeOut Only valid if found in section [GLOBAL] This key 
may change the time out behaviour of  the printer in 
printing mode using the parallel port (centronics). 
Please ask the distributor for details. Especially when 
not all pages are printed, and the rest of the first job 
is printed on arrival of the next job, try to solve this 
problem by setting the keys value to 1. 

LJ_Mode_OverRead_EO
F 

DIMM only version_: Can only be turned on in a 
Searched_... section. Once set, ELP will not exit on a 
found UEL command. 

ELP_MAX_HEAP Maximum Memory which can be used by the printer 
filter. Default 1MB, can maybe extended to 1.5 MB 
or a little more, depending on the printers total 
memory. 
If there was too many memory allocated, the printer 
will hang with a 49.5001 printer error. 

 
 
 
AP-ELP Boxes 
 
There are two external print boxes available, one which can print from Lan2Lan or 
from Lan2USB and another larger one, which can handle up to 4 Lan2USB and 52 
Lan2Lan connections.  
 
The boxes do operate the same as the printers, but have both a web based interface 
to be configured. The special ini-file keys mentioned above do not apply, but the 
rest does. Even the rule assignment by port is possible. 
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UNIX, Linux, Aix, Solaris, VMS 
 
Note: The distributed, PDF and time functions are not (yet) supported. 
 
Compilation of the sources 
 
The compiled version can downloaded from the manufacturers home page, or 
supplied by the distributors. Just in case, you are using an unsupported operating 
system, here are the steps to compile the sources: 

1. Copy all provided source files into any directory of your work station. 

2. All file names must be in lower case! Use "chmod 777 lower.bat" in order to be 
able to execute a small shell script, which converts all files from upper to lower 
case. 

3. Be sure, that the first code lines in definit.h and convert.exe the command 
#define copy_unix is NOT surrounded by /* and */. 

4. In order to compile the sources you need a full ANSI C compiler. The kernel 
compiler for HP UNIX work stations is NOT a full C compiler! 
 
Compile and link convert.c and barcode.c in one command line like this:  
cc convert.c barcode.c  
 
The result is usually a file called a.out. Maybe you want to rename it to 
elp_convert. 
 
Maybe you need to add a unique outfilename to the command line.  
cc convert.c barcode.c /out:elp_convert 
 

5. Finally use "chmod 777 elp_convert" in order to make the file executable. 
 
Use and test the ELP program 
 
The ELP software must/can be used with the command syntax described 
 later in this chapter . 
 
Important: Please do not use any blanks in the Arguments 
.  
However, there is a way to pass an argument including the blanks to the ELP 
program, simply set the blanks in the argument in double quotes. The above sample 
then will be like this: “-d/program files” 
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The next line describes all possible program call arguments. bc_convert is the name 
for the executable file:  
 
bc_convert IN_DATA OUT_DATA [-dWorkingDirectory] [-eDefaultElpFile] [-
o[i|o]] [-cIniFile] [-p1PrinterName] [-g#] [-p2MachineName] [-p3UserName] 
[-p4DocumentName] [-p5TotalPages] [-MeMailSW] 
 
IN A) Filename of incoming PCL 5 print stream, including path, 

or  
B) STDIN This special "file name" name will advise the ELP 
  software that the incoming data is processed 
  through the STDIO input.  

 
OUT A) Filename including path of the ELP output data, or 

B) STDOUT This special "file name" advises the ELP 
  software to dump the data to the stdio output.  

 
-cIniFile -c followed directly with a full path plus file name of the 

converter 's command file name. This file defines a huge range 
of additional ELP commands, like triggers.  

 
p1 to p4 Arguments If those arguments are provided, they will be documented in 

the accounting module, see page 118. 
p1NameOfThePrinter 
p2NameOf the Workstation/Server or PC 
p3NameOfTheUser 
p4Document description. 
IMPORTANT: 
See blank statement at the beginning of this chapter! 
 

-p5TotalPages If provided, it will be also documented by the accounting 
module, but for PCL 5 data streams, the number is verified by 
Form feed counting.  
 

-p9Port TCP/IP number or port expression of the windows printer 
driver. (Not supported under pure NT 4.0 and Unix) 

 
-MeMailSWPath Enter the full path and program call for the BLAT email 

software. (Not supported under Unix) 
 
-FPdfSWPath Enter the full path and program call for the Lincoln PCL to 

Adobe Acrobat Reader, PDF format, converter. (Not 
supported under Unix) 
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-q0ShareName Printer share name, mainly for MS windows in order to resend 

the same job to the same queue using the variable 
#PCNAME#\#PRINTERSHARENAME# 
(Not supported under NT 4.0 and unix) 

 
-q1DriverName Also mainly for MS windows to setup triggered rules which 

belong for all activated printers, using a special driver. The 
command line option is stored into the variable 
#PRINTERDRIVERNAME# 
(Not supported under NT 4.0 and Unix) 
 

-q3DebugFile Full path and file name of debug file. If no Slash (unix) or 
Back-Slash (Windows) is provided then log_file.txt is used in 
the working directory path. To change the name there use 
log_mode_filename key in the ini-file. 

 
-q7HostName in most cases the same as –p2, but without the leading \\. The –

p2 is taken from the job definition, so in are cases the variable 
does not include the host name, but the IP address. So this 
variable does hold certainly the Host name, without leading \\! 

 
-q8 Unix/Linux only. If the –d parameter is set and the data is 

passé din via STDIN, ELP will first read all data in and store 
into a temporary file. This method needs to be set, if 
PreParsing the data streams is needed. 

 
All the following arguments are all optional and should not be used in the command 
line, because they can be defined as well in the ini-file. 
 
-dWorkingDirectory  -d followed directly with a full directory path advises the ELP 

software, where to look for the macro files. 
 
-o Same command as INI-file DEBUG_INDATA and DEBUG_-

OUTDATA commands, which should be preferably used. 
This parameter is used for archiving print files, or simply for 
input and output data caption. Note: Can only be used, when -
d command is given as well. This parameter will generate up 
to two files: in_data.prn and out_data.prn are produced in the 
WorkingDirectory. 
The out file can be used to send the data to an additional 
device, like an archive system. 
Options: -oi stores only the incoming data 
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  -oo stores only the outgoing data 
  -o stores both data streams 

 
-eElpCommandFile  Note: The ini-file does replace this old command. 

-e followed directly with a full path and file name of the ELP 
command file name advises the program to process every print 
file according the ELP commands in this file. 
 

-g# The positive number stands for the DEBUG Mode. As this 
mode is usually set in the ini file using the key LOG_MODE 
the only interesting number here is -g20. This number will 
document only on the Windows platform the processing speed 
of the filter. The needed speed time is recorded in the file 
log_file.txt in the forms directory. 
IMPORTANT NOTE: -g must be AFTER the –d parameter! 
Note: If an virus scanner is running which monitors file 
access, the system my result in very slow printing. 

 
Examples for program calls: 

convert INfile.tmp OUTfile.prn 
convert STDIN STDOUT < INfile.tmp > OUTfile.prn 
convert $1 STDOUT –d/home/user/ELP-dir | LP ...... 

The first 2 examples used on an UNIX platform, perform exactly the same action.  
 
For test purposes, use some of the demo files described later in this manual. 
 
 
Using the /etc/printcap 
 
Using the old printcap method for printing, a definition in the /etc/printcap could 
look like that: 
 
ps44re:\ 
         :cm=lpdfilter method=auto color=no:\ 
         :rm=ps44:\ 
         :rp=AUTO:\ 
         :sd=/var/spool/lpd/ps44re:\ 
         :lf=/var/spool/lpd/ps44re/log:\ 
         :af=/var/spool/lpd/ps44re/acct:\ 
         :if=/opt/elp/filter:\ 
         :ar:force_localhost@:\ 
         :tr=:cl:lk:sh: 
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Ps44re is the printet name and ps44 its host name. the shell script filter will contain 
the elp command using STDIn and STDOUT. 
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Using Common Unix Printing System CUPS 
 
ELP can also be installed as a filter into the CUPS environment. There can be found 
excellent manuals on the internet for this purposes. Here is the short reference:. 
 
1.  Please extract the provided zip file to this directory: /usr/lib/cups/elp 

Take care about the access settings using chmod for the complete directory 
reading, writing, creating and erase. 

 
2. If needed store a new "convert.ini" in the directory  
 
3. Create a file "ELPToPCL" under /usr/lib/cups/filter with this content: 

 
#!/bin/sh 
set –x 
[ -n "$6" ] && exec <"$6" 
/usr/lib/cups/elp/elp.Linux_smp STDIN STDOUT -
d/usr/lib/cups/elp -c/usr/lib/cups/elp/convert.ini 
 
Note¨The last 2 lines here are actually one line. 

 
4. Create file "my.types" at /etc/cups with the content "application/elp" 

The "my" is subject to be changed, the extension ".types" is a must 
 
5. Create any printer 
 
6. Edit this printer setting at /etc/cups/ppd and include the line  

*cupsFilter:    "application/elp 0 ELPToPCL" 
 
7. Rename this printer in any name, which is not predefined in cups e.g 

"ELP.ppd" 
 
8. Create a new printer in CUPS using "raw" printing. This means without a 

driver 
 
9. If CUPS would print now, cups will check in any case at /etc/cups/ppd if an 

associated driver could be found.  Example the name is "Testprinter" the CUPS 
checks for a driver in "/etc/cups/ppd/ names "Testprinter.ppd". 
 
So change into the directory /etc/cups/ppd and creat a "Link" with  
"ln -s /etc/cups/ppd/ELP.ppd /etc/cups/ppd/Testprinter.ppd" 
 
Result 
drwxr-xr-x 2 lp sys 200 Dec 17 07:59 
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drwxr-xr-x 6 lp sys 688 Dec  9 07:58 
-rw-r--r-- 1 root root 73040 Nov 20 18:37 ELP.ppd 
-rw-r--r-- 1 root root 73040 Nov 20 13:15 ELP.ppd_org 
Lrwxrwxrwx 1 root root 11 Dec 17 07:59 Testdrucker.ppd -> ELP.ppd 
Lrwxrwxrwx 1 root root 11 Nov 19 09:56 edv2.ppd -> ELP.ppd 
Lrwxrwxrwx 1 root root 11 Nov 20 15:27 tester.ppd -> ELP.ppd 

 
10. Announce this new function to CUPS. 

"lpoptions -p Testprinter -o document-format=application/elp" 
 
 If this is the first printer using this function, CUPS creates a new file at  

/etc/cups named "lpoptiosn" 
 
Now all printers of this type can be registered direct there, if they should use ELP. 
 
11. Printing to CUPS via UNC path, e.g. using Net Use DOS commands may cause 

you a headache, because the job is passed through a CUPS filter in RAW 
mode. In that case, simply edit /etc/samba/smb.conf and in section GLOBAL 
set a small # at first column in line “cups options = raw”.  
 

12. If you need the printer name within ELP in a rule or simply as a variable, Add 
in rule GLOBAL this key: 
GetEnvVariable=PRINTER;PRINTERNAME 
 
Forther environment variables are described here: 
53Hhttp://www.cups.org/documentation.php/doc-1.4/man-filter.html 
For OMR, please do not use CLASS as a printer name. 
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AS/400 
 
End of 2003 the main functions had been ported also to the AS400 platform as a 
spooler extension. Due to time limitations, only the following functions had been 
successfully tested: 
 
Barcode 1D and 2D, ELP Functions, Search and Replace, Trigger, Archiving 
 
On the AS/400ELP is able to use Host Print Transform (HPT). The minimum 
version for the operating system is V4R5M0. 
 
Installation:  
Create the bibliotheca DIRBCD:  CRTLIB LIB(DIRBCD) 
 
Then restore the SAVF via FTP or any other toll back to this bibliotheca. For 
initialisation call the following commands: 
 ADDLIBLE LIB(DIRBCD) 
 CALL PGM(DBINIT)    
 
The software DBINIT creates all needed directories (/Toolmaker/DirectELP400), 
The convert.ini has to be stored in the directory „/Toolmaker/DirectELP400/elp“  
 
How ELP works: In order to convert the spool files, ELP uses the Exit Program of 
the As/400 print output software, which is addressed in the OUTQ of the printer. 
 
The Exit Program is invoked using the following OUTQ command: 
 
 CHGOUTQ OUTQ(...) USRDTATFM(DIRBCD/DBWTREXT) 
 
Then the printer can be started using standard methods: STRRMTWTR or 
STRPRTWTR. 
 
The conversion of printing data streams is realized through this Exit Program. 
Previously the data has to be converted to PCL 5 via HPT. It is important, that the 
printer model ort he  WSCST object is addressed! 
 
After the HPT conversion ELP is called and finally the data is sent to the printer. 
 
Known problems 
 
The EBCDIC conversion is only tested for the above mentioned module. Others 
may fail du not having been tested, but it can be fixed pretty easily. 
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Another way is to print directly from the AS400 to a Windows Queue which has 
ELP installed. The AS/400 command for this is: 
 
CRTOUTQ OUTQ(TEST) RMTSYS(HOSTNAME) RMTPRTQ('The full printer 
name of the PC') CNNTYPE(*IP) DESTTYPE(*OTHER) TRANSFORM(*YES) 
MFRTYPMDL(*HPIII)
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ELP and Novell™ Netware  
 
Unfortunately ELP currently can’t be installed direct on a Novell Server. On the 
other side, as Novell has implemented their own print server, it does not make sense 
to queue first the data stream on a local PC. In other words, for the standard Novell 
installation ELP must be installed on the local PC, but even doing this, by default 
the print data stream will never pass the queue with the installed ELP print 
processor. 
 
There are two ways to force the data stream to pass the processor of a local PC: 

1. Connect the port f the ELP queue to LPT1, 2 or 3. Then use the capture utility 
from Novell to reroute the port to a server queue. 

2. Install on the Novell Server the LPR printing capabilities, set the port of the 
local queue to LPR printing and connect it to the server and the installed printer 
queue. 
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MS Windows 
 
The software was tested as well on Windows Cluster and various Terminal Server. 
On Cluster server the installation needs to be done by Hand. See chapter MS Cluster 
Server. 
 
Important things about the installation: 

• You need to be logged on as administrator, in order to install the software! 

• If other users are allowed to access W-ELP of the installation PC, make 
sure, everybody has the READ permission in the installation directory, and 
READ/WRITE/CREATE permission to the forms directory! 

• You need the Windows Installation pack installed.  

• During the installation 1 Service DLL is installed, but it is not needed to 
run the main ELP software package. ELP runs as a print processor and is 
only active, when a job is on PRINTING status in an activated queue. 

 
It is strongly suggested to configure the email software as described later in this 
manual: This will enable the print processor to send out notification mails on any 
detected problems while processing print jobs. 
 
W-ELP takes unless a print job is proceeded no system resources. 
 
 
Update ELP Software 
 
1. Copy all provided files into your Work Path. If you have a service contract, you 

may install PPAdmin from the distributor WEB on a second PC, and the copy 
all files from the program directory into the same directory on your productive 
system. 
 

2. Check the provided update documentation, if you need to update the print 
processor as well. In this case please uninstall the print processor and perform a 
full new installation. 
 
WARNING:  Save all your macros and changed ini files before. After the 
installation write them back to the WorkPath directory. 
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Uninstall ELP Software 
 
1. Make sure the spooler service is running (other type in the DOS command 

prompt: 'net start spooler' or  Start  -> Settings -> Control Panel -> 
Administrative Tools -> Services -> Print Spooler ), otherwise the un-
installation will fail. 

 
2. Simply go to Start  -> Settings -> Control Panel -> Add/remove programs and 

select the “ELP + Queue Control” for un-installation. The uninstaller will 
proceed the following steps: 

 
 Reset printers, which are still running with 'welpprint' as print processor 

(switch from 'welpprint to 'WinPrint')  
 Remove registry entries 
 Delete shortcut in Program Group/Start menu 
 Delete installation directory with program files 
 Restart spooler (first stop spooler, then start back again) 
 Delete print processor dll in system directory 
 Remove print processor 'welpprint' 

 
NOTE: While uninstalling, the spooler is stopped and restarted (net 
stop/start spooler). So make sure no important print jobs are currently 
processed (e.g. on a print server). 
 
 

Install ELP Software  
 
This chapter is only for windows user. Unix user need only to add the converter and 
argument call like described before in a piped command line. 
 

1. You need to be logged on as administrator, in order to install the software! 
 

2. If other users are allowed to access W-ELP of the installation PC, make 
sure, everybody has the write permission in the installation directory! 

 
3. Make sure the spooler service is running ('net start spooler' or  Start  -> 

Settings -> Control Panel -> Administrative Tools -> Services -> Print 
Spooler), otherwise the installation will fail. 

 
4. Assure that all previous versions of welpprint ELP print processor are 

removed from the system, i.e. registry entries, 'genprint.dll' in print 
processor directory. 
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5. Start the program INSTALL.MSI, which will guide you through the 
installation process. The installer alters the following components on your 
system: 

 
 Create directory and copies required program files 
 Add registry entries 
 Add shortcut in Program Group/Start menu 
 Copy print processor dll to system directory 
 Add print processor 'welpprint' 

 
If the installation fails pretty much at the end, then please check, if the program 
registration in the start menu was already made. If this is the case, then you may 
finish the installation by hand at point 6 of the next chapter. 
 
 
Install ELP Software by Hand 
 
If the installation process did not finish, then you have the chance to install the 
software by hand, for  Microsoft Cluster Server see next chapter!. Here are the steps 
to proceed for normal PCs: 
 
1. Install W-ELP on any customer PC or Laptop etc, like e.g. yours. 

2. Start the REGEDIT software from the command line for example  

3. Go to HKEY_LOCAL_MACHINE and Software, mark the WELP folder and 
export it into the WELP program directory  

4. Copy all files from the WELP directory to the troublesome machine, into the 
same installation path (no blanks). Maybe with a memory stick or so or by 
connection PCs.  

5. Start the REGEDIT and import the settings  

6. Call DOS and switch to the WELP installation directory. Now comes the 
important second: Execute INSTALL.exe. Now the print processor must be 
installed.  

7. Reboot  

8. Maybe put PPADMIN into the start menu 
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Uninstall ELP Software by Hand 
 
In very rare cases, it could be, that you need to uninstall the software by hand.. Here 
are the steps: 
 
1. Stop the spooler 

2. Delete at C:\WINDOWS\system32\spool\prtprocs\w32x86\welpprint.dll 

3. If windows has created a copy of that DLL in 
C:\WINDOWS\system32\dllcashe, please delete it as well 

4. Start the spooler, and maybe restart the TCP/IP print services 

5. Open the registry and erase the path \ 
HKEY_LOCAL_MACHINE\SOFTWARE\WELP 

6. Erase the c:\programe\welp directory 
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ELP installation on a Windows 2003 Cluster 
 
Unfortunately ELP currently can’t be installed direct on a Windows 2003 Cluster 
server (tested only on 32 bit Intel architecture) 
 
Install the same PCL5 printer driver you want to use for W-ELP on each node and 
on the cluster.  
 
Make sure that you created a Spooler recourse in a Cluster Group and make sure 
that once a node becomes active for the spooling process this node has access to a 
clustered disk where the W-ELP configuration files, forms, etc. are stored. In the 
following this clustered disk will be named W-ELPClusterDisk. 
 

 
 
The following procedure must be repeated per cluster node. 
 
1) Bring one node active which owns the spooler recourse and the W-

ELPClusterDisk. 
 

2) Install W-ELP  
 

3) Start the registry editor and locate the cluster recourse for the print spooler. 
Here it's HKEY_LOCAL_MACHINE\Cluster\Resources\535459d5-a58b-
4828-adfa-9dc5513086f8 
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Create a key welpprint with this values accordingly 

 

 
 
4) Locate the same registry hive as the clustered spooler recourse on your local 

system %windir%\system32\spool\drivers. Here it's 535459d5-a58b-4828-adfa-
9dc5513086f8 

 

 
 

Create a subdirectory prtprocs\w32x86 within the 535459d5-a58b-4828-adfa-
9dc5513086f8 subdirectory and copy the file welpprint.dll there (you will find it 
within the subdirectory %windir%\system32\spool\prtprocs\w32x86 
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5) (must be only done once and not per node) Copy the files from the W-ELP 

installation directory to the W-ELPClusterDisk (e.g. in a proper subdirectory like 
K:\...). Make sure that the users have correct file permissions (read installation 
instructions on a non-clustered Windows installation for more details). 

 
6)   Start PPAdmin and set the paths 

accordingly, e.g. like: 
 

7)   In order to activate ELP open the 
printer driver, display the 
enhanced tab, and turn off the 
Enhanced settings, then click 
on Print Processor and select 
welpprint. 
 
The way with PPAdmin Install 
tab is unfortunately not possible 
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Configuration of Blat for MS Windows 
 

Please read also the license 
information in the administrator 
manual. 
 
With the installation of the MS 
Windows version of ELP, 
blat201 was also automatically 
installed, and it needs to be now 
configured. 
 
 Start PPADMIN and open the 
ADMIN Tab. Click on the Blat 
Configure button and fill out the 

provided fields. Remember, no blanks are allowed in the path name.  
 
Close the window with OK and enter into the “Admin email” field one or more 
comma separated email addresses in the next field and press the Apply button. 
Finally the installation can be tested clicking the “Send Testmail” button. 
 
Starting from now, any important failures during the program execution will be 
reported to those email addresses. 
  
Hints:  
1. If anything fails, open the Parameter Description, and setup blat by hand. 
 
2.Blat provides quite a number of command arguments, which are currently not 
used. On request, add them to the command line in PPADMIN. The full description 
of all commands are described in Blat’s README.TXT file. 
The following arguments are currently used: filename, –to, -s and –attach. 
 
Now it is a good time to press the top right ‘?’ and start reading. In about 30 minutes 
you will get an overview about the basic functionalities. 
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Change License Key 
 

On the License Tab the actual 
license key, the local machine 
name and if the key is valid, 
the amount of licensed printers 
and the Module list are shown. 
 
To change a key, enter the 
new value and click on apply. 
 
Note: The key won’t be 
checked if it is valid. If an 
invalid key was entered, 
printing on a welpprint 
configured printer will not be 
possible. A message box will 
inform about that. 
 
The contact address and the 
actual version are shown when 
the About button is clicked. 
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Configure PPadmin’s archive reprint tool on a normal user  PC 
 
The powerfull MyPrintArchive function of ELP can be used to collect, reprint, sort 
data streams or simply as a print library. In most cases PPadmin then needs to be 
installed on a local user PC.  
 
If the installed W-ELP software is accessible from the user PC e.g. via a connected  
network path, skip the first point 
 
1. Copy the following files from the installed ELP server to your local PC or into 

an accessible network directory. Any directory is allowed. 
PPADMIN.EXE, ARCHIVE.INI, LANGUAGE.INI and all files beginning 
with TIPS*.* and the ones ending with *.LAN 
 

2. Create a shortcut on the desktop and / or task menu and / or start-up menu of 
PPAdmin.exe. Open the file explorer, right mouse click on PPAdmin.exe and 
select: Create short cut. You then can drag this new icon into any menu you 
like. 
 

3. Right click the mouse button on the new shortcut(s) and select properties. Open 
the register where you see the software execution call …\PPAdmin.exe. In 
order to set PPAdmin into Archive mode, add at the line end a blank and /A 
(Uppercase A!) 
 

4. Open the archive.ini file into notepad and change the InArchiveDir to your own 
needs. You can either point to a shared network volume or use this definition 
\\server\sharename[\directory]  
You may insert several keys for more directories. There is no difference in file 
handling if you use the In- or OutarchiveDir key, they are only for finding the 
path. You may also use the variable #USERNAME# in order to open a user 
specific subdirectory. 
There are quite a view more possibilities to be set, even to load another ini-file 
for getting the archive directories names. All options are described in the file. 
 

Once the shortcut is called, PPAdmin shows up with only the Archive register. 
 
Tipp: If the user should only be able to print all his stored files in one shot, use 
either a batch file like this: 
copy /b d:\archive\*.* \\server\PrinterShareName 
Del /Q d:\archive\*.* 
Or the way described in the MyPrintArchive chapter in this manual. 
 
You may also change the tips.ini.* files with notepad to give more company specific 
help to your users. 
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Sharing NT / 2000 / XP printers Queues using TCP/IP services (LPR) 
 
If not yet done, install the unix print services via Control Panel – Add Software –
additional file and print services – Mark Unix print services. 
 
Then check, if in the registry the passthrough option for the service is set. 
 
1. Start the registry editor (regedit.exe) 
2. Open   
HKEY_LOCAL_MACHINE 
   SYSTEM 
      CurrentControlSet 
            Services 
               LPDSVC 
                   Parameters 
3. From the Edit menu select New - DWORD value 
4. Enter a name of SimulatePassThrough and press Enter 
5. Double click the new value and set to 1.  
6. Click OK 
7. Reboot the PC in the key was added, or stop and start the spooler. 
 
Then open the services window from windows and check if the TCP/IP Print 
services for LPR (Unix Printing) … is started. If not please start. 
 
Finally open the windows print queue, where ELP is activated, and set it to hold. 
Enter also a release name. if possible use for the first queue the name 9100, as this is 
the printer port most hosts print to. 
 
Now change on the host the IP Address of the LPR command to the one of your PC. 
In order to get the PCs IP address open the dos box and enter IPCONFIG. You may 
also turn the printer off and change temporarily the PC IP address to the printer one. 
This has the benefit, that nothing needs to be changed on the host. 
 
Once a job is now printed, it should arrive in the queue. In order to release the job 
turn the job holding off. If nothing arrives, the host is using another protocol. 
 
If the client is a PC, then connect the new queue on the server using TCP/IP Port, 
entering the LPR protocol and VERY IMPORTANT: Activate the LPR Byte count 
in the port register of the printer driver settings. 
 
If any problem do show up, please do not hesitate to send an email to the support 
address, see at PPAdmin ->license tab -> About information. 
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How to print from other Windows PC to the Windows ELP queue 
 
1. Release the printer queue with the installed print processor for everybody. 

Therefore call the printers properties, and release the printer by giving a useful 
name. 
The printer queue is now ready for being shared. 
 

2. In order to connect any other windows PC to this shared queue, open the 
printer properties of the local PC. Note, you need a PCL 5, 5E or 5C driver!  
 
Select the ports tab. 
Add... 
Select Local Port 
New Connection 
Enter the IP address and the previous given Useful Release Name 
Close all Windows up to the ports window 
Mark in the Port list the new generated port. 
OK 

 
 
Now you can 
start printing 
from this PC 
using the 
 W-ELP, 
installed on 
any other 
server. 
 
 
 
 
 
Set the wait time for PDF conversion in the Archive menu 
 
If in the Archive register pressing the View button the conversion form a PCL print 
file into a viewable PDF document takes longer then 10 seconds, maybe because of 
an extremely large print file, or a slow PC, a notification window will pop up.  
 
This time frame can be freely set in 0.5 seconds steps using the registry key 
PDFConvWaitTime at HKEY_LOCAL_MACHINE -> SOFTWARE -> welp -> 
welpprint. 
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First steps with ELP Windows Software  
 

  
 
When you start your PPAdmin the first time a Start-up Agent is shown. 
 
This Start-up Agent helps you to configure your ELP  software quickly for the most 
common tasks.  
it offers quick access to the global setup, printer activation, Forms and printer 
handling, SAP_Unicode and to the emulations. 
 
The default recommendations are listed in the left column of the yes/no table.
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Choose the Admin Tab 
The options program call 
and Workpath are 
predefined from the installing 
process. You may put now 
the convert.exe into any other 
directory or rename the file. 
Then change the Program 
Call setting. 
 
The workpath should lead to 
a directory which the spooler 
has the full write and read 
permission. The In and Out 
communication files to the 
convert.exe are stored here. 
The workpath should end 
with a ‘\’, otherwise it will be 
added. In any case, Workpath 
can dynamically be changed 
using the Ini-File kesy 
WKDIR. 
 

The  entry may contain any additional command described in chapter "111HUse and test 
the ELP program", except IN_DATA, OUT_DATA and the –P Arguments. They 
are fixed provided by the W-ELP print processor.  
 
For printing barcodes, there are no additional options needed, but for the Form 
Management the –d command is required, as well as the –c command for enabling 
ELP and other functions. 
 
In most cases the paths of -d and -c commands are directed to the Work Path. To 
keep the entry short and easily changeable, the Work Path can be replaced by the 
command #WKD#. 
 
As the usage of the –c command is strongly recommended, the most common used 
entry of the Arguments are: "–d#WKD# -c#WKD#\convert.ini ".  
Note: The In- and Out-file and –P# parameters are handled by default and there is 
no need to add them to the argument text. 
 
As an extended option you can choose running the debug mode or not by clicking 
the checkbox (“show execution program”). If you chose to run the debug mode, 
then a dos prompt will appear and show the processes. 
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The number entered next to “Deadlock” defines the time which the W-ELP print 
processor is waiting until the convert.exe program, which is the ELP performing 
software, needs to be finished.  
A value of minus one indicates an infinite wait time. The positive number is the wait 
time in minutes. Example for a value of 2: The process will either return when the 
ELP software is finished, or run into its error recovery mode after 2 minutes.   
 
The DIMM mode key is default turned off. It should be set, if the W-ELP windows 
software is used to configure and emulate an printer ELP firmware DIMM. 
 
The Run as user key is default turned off. Usually it is only needed to be turned 
ON, if data needs to be send outside of the PC/Server using In/OutArchiveDir, 
In/OutPort, the Software is physically installed on another server or any batch 
process. It is also needed, if applications with printer access are called via any 
CALL key. Further details are provided at those chapters. Please use always UNC 
names for addressing the directories or your software. Volume names may not 
work! 
 
The Password key is by default enabled, and the password window is shown on 
start-up of PPAdmin. If no password is entered, and the switch is set, the password 
windows does not display again on start-up. 
 
The Startup Agent checkbox is by default enabled, so the start-up Agent is shown 
on start-up of PPAdmin. If the checkbox is not set, the start-up Agent does not 
display again on start-up. 
 
View Tabs: Macro, Admin, Ini-File, Install, Archive, email-, QueueControl and 
License: default most of those buttons are turned on, and then the described tab 
(register) is displayed. Turn them off, if you do or the user should NOT use them.  
 
***IMPORTANT***: 
Once the admin tab is turned off, the admin page will not be displayed on the next 
progarm call. So you will NOT be able to unhide the Admin tab again. 

The only way to do that is to open the 
PCs registry, -> 
HKEY_LOCAL_MACHINE -> 
SOFTWARE -> welp -> welpprint and 
change the value of the key 
Showregister to 159, the default value, 
or 255 for the actual maximum value. 
 
email and PSD Call can only be 
entered, after the freeware Mail 
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Software, which is the case for newer versions of the software. By clicking on the 
respective “browse” button you can browse your system to find the executables for 
the PDF or administrate the email Software. 
 
Further information about the email Software entries can be read after clicking on 
the button Parameter Description- 
 
It is strongly recommended to activate the email software and enter some valid 
email addresses into the Admin email field. ELP will send out an email if the 
software fails during processing the data. These addresses are used to get emails 
about errors in print jobs. When you enter more than one the addresses they must be 
separated by comma. By clicking on TestMail, the entered email addresses must get 
a test mail from PPADMIN within some minutes. 
 
On APPLY all changes of this screen are stored. 
 
The buttons “show last logfile” and “show account file” open the corresponding file 
in notepad. Then you will be asked if you want to delete them. These files are 
normally saved in the Working directory. 
 
The installation is now nearly finished. The last step, described in the next chapter, 
is to enable the ELP functionality within any printer driver. 
 
 
Activate ELP printing Windows version. (not Cluster) 

 
Start PPAdmin and select the 
Install tab.  
 
The left window lists all installed 
printer drivers/queues which are 
using the WinPrint processor, the 
right list drivers/queues with all 
the activated ELP processors. 
 
Once any entry of those two lists 
is marked, the port and the name 
of the driver is displayed below 
the lists, and you may now install 
/ un-install the ELP process, 
simply by clicking on the 
activated direction key << or >>. 
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Note: If no printer is listed, and there are some installed on this PC, then open direct 
the printer properties and change by hand the print processor to welpprint. We do 
know some printer manufacturer do use their own WinPrint replacements. 
 
After clicking on >> a new window may 
appear, which reminds you to set the 
printer driver to the correct configuration. 
 
It is important to turn the ‘Enable 
advanced printing features’ off. 
 
Note: The licence model of the  
W-ELP Software for Microsoft Windows 
is limited to n installations. The installer 
Tab allows only the maximum 
installations of ELP print processors. 

 
 
 
 
 
To test the installed printer click on the button 
“Mark printer to print demo file”. A window 
will appear in which a list of all available 
demo files (*.pcl) are displayed.  
 
Due to licensing reasons, once a valid key is 
provided, the barcode functionality might be 
permanently turned off. 
 
 
 

 
To continue we recommend to click now on the top right “?” button and start the 
self training. 
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Error message, without any text… 
  

In very rare cases, this error message will 
pop up when printing from another client. 
This message is NOT produced by ELP, I 
comes from the MS Windows software 
itself. 
 
Usually the problem is caused by wrong 
access rights. It seems that the suggested 
EVERYONE user rights in the WELP, 
WELP\forms and WELP registry settings 

are not enough. Especially when the user is located in another domaine. 
 
In that case you need to grant the user to administration rights. But ONY for those 
directories. 
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Collect Page Counter from your network printers, FleetMeter 
 
ELP can collect from all network printers quite some information, beginning with  
actual page counters and ending with any MIB information you can get out of the 
printer. 
 
There are 2 ways to collect those information:  
 
1. Default and always as the first try: Using the SNMP (Single NETWORK 

Management) Protocol.  
 

2. Only if collection the page counter and the printer name fails via SNMP, as 
maybe the printers SNMP support is turned off or the network box is not 
supporting it, ELP may use on request as well the standard @PJL (Printer Job 
Language) commands.  
 

In order to setup the default setting start PPAdmin -> open the Admin register -> 
Click bottom right the “Page counter” -> Configuration 
 

 
 
The @PJL communication settings: This is an optional selectable way of 
collection the printer name and page counter if SNMP fails. Once found there,  ELP 
will sea8rch for the printer name in the SNMP database and if the printer is not 
found, proceed with the “DEFAULT” printer name. See below for further info’s. 
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The settings and their explanations of the PJL method are: 
 

Ports to try The default network listener port is 9100. However, if for 
example you are printing via a three port jet direct box, your 
port named for the 3 printers could be 9100;9001;9002.  
Enter all port numbers separated by semicolon beginning with 
the most important first.  
 

Tried connections  As the printer is maybe busy, or it takes some time him to 
reply, this field holds the number of times, ELP tries to connect 
to the printer.  
 

Wait time The time in seconds ELP waits between each connection try. 
 
The last 2 numbers resumes together into the maximum time ELP waits and tries to 
connect, when the device is either offline or busy printing or when browsing a range 
of IP addresses, there  is no printer at the requested address. 
 
The more tries are set and the longer the wait time is, the longer ELP needs for 
analysing each IP address, which was not found via the SNMP process. 
 
The top SNMP frame usually needs to be configured at all, unless you do not want 
to setup your own data base system, accessed by standard windows ODBC methods. 
 
You can select any data base system and any table for storing the printer and their 
MIB information. As default the EXCEL spread sheet is selected, but you can also 
name any links DNS name and access the provided table. 
 
The default ECXEL data base is named MIB.XLS and is located in the PGCount 
subdirectory. 
If your printers are not listed in that directory, ELP looks for the “DEFAULT” 
entry, which is based upon the Hewlett-Packard printer MIB. 
Feel free to add any time new MIB entries as columns.  The manufacturer commits 
to add them as well to the default delivery file, when you this kind of information to 
your local distributor. 
 
For the CSV field separator can be used any ASCII character, most popular is the 
comma or semicolon. The used character is depending upon your spread sheet 
calculation software default setting.  
 
Finally if you want to use the automatic email functionality, enter here the email 
addresses, to who the result CSV file should be sent.  
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Automatic collecting Page Counters, time triggered 
 
If PPAdmin is started with the command line switch /P it starts up with the page 
counter screen and performs automatically the research, using the last window 
settings. So in order to setup a functionality like that, proceed through those steps: 
 
1. Start PPAdmin without using any parameter. 

 
2. Open the admin window and setup and test the email functionality, as in most 

cases the results is sent out via email. 
 
3. Call the page count option 
 
4. Configure the system, especially the email addresses 

 
5. Return to the page count main 

window and configure it once 
to your requirements, like the 
mode and all option. 
Obviously PPAdmin has to 
send the stuff by email and 
shut down after finishing the 
process. 
 

6. Click on Run to start the 
process in order to test your 
settings and even more 
important to store the settings. 
 

7. Is the result like you need it, 
then finally set up the time 
based process. Windows offer 
several methods to call 
applications time based. 
 
The main ELP manual 
describes time based printing. 
You can use the same freeware 
software System Scheduler loadable at 54Hhttp://www.splinterware.com/ to setup 
the time based page counter functionality. 
 

8. The final trick is to call PPAdmin with the switch /P, which uses always the last 
performed page counter research as the default setting. 
c:\programme\welp\PPAdmin.exe /P 
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Software support 
 

SAP R/2 and R/3 
 
ELP commands can be used directly in the SAPScript form, but make sure, that you 
do not print using the SAP-WIN method. Another trigger method is to define in the 
SPAD some new print controls, which do contain the proper commands. 
 
One possible method of the usage of ELP for Unix within SAP is like this: 
 
Connection method (Koppelart) L seem to be the easiest and maybe also the best 
solution to integrate ELP within SAP. 
 
Generate in Transaction SPAD a new printer, store it and call the Pull-Down Menu 
Edit->Command set (Bearbeiten ->Kommandosatz. A new field is opened and enter 
there for example an „e“ for ELP. After the double click on that „e“ a new windows 
is popping up, where the commands can be edited. Enter the exact same command 
as used in the Instance or Default-Profile. The only difference is to add to the 
command an „_e“. 
 
Example: Instance profile: rspo/host_spool/print = lp -d " &P" "&F" 
 
New command set: lp_e -d "&P" "&F" “&o” “&T” 
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In the last Step, generate a shell script in the search path of the R/3 systems names 
“lp_e”, which performs the following actions: 
- The input needs to be send through the ELP converter and most likely via stdout 
- the real lp programme is called using the piped command, see page 112H19. 
 
Here is an example of the lp_e shell script, how the above values can be passed into 
ELP: 
 
/opt/elp/elp.HP-UX $3 STDOUT -d/opt/elp -
c/opt/elp/convert.ini -p1"$2" -p3"$4" -p4"$5" | lp $1 $2 
 
$2 is the printer name 
$3 the print file name 
$4 the user name 
$5 the document name (Title) 
 
Once this addon works, the ELP service can easily be activated on any printer 
within the system, as only the „e“ needs to be set via edit->command set. 
 
Here is a list of  all available parameter SAP can pass into the shell script, and there 
they can be passed by command line into the ELP printing process: 
 
If the command is to contain a '&' character then this must be written as 
'&&'. The following replacement parameters are defined: 
&C Number of copies 
&D Department of the recipient 
&F Name of file with the print date (including path) 
&f Name of file without path 
&H/// , if host spool cover page required, otherwise 
&I Job name with DB ID 
&J Job name without DB ID 
&L Format type 
&M Client of spool request owner 
&m Client of print request owner 
&O (SAP)Name of spool request owner 
&o (SAP)Name of print request owner 
&P Name of external output device 
&p Path name of output file 
&R Name of recipient 
&S Name of SAP output device 
&T Title 
&t Fax number 
&U Host spool cover page required (X=yes, N=no) 
&Y SAP priority (1-99) 1 is the highest priority 
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Alongside these standard parameters the following parameters are also 
available for the OMS command template: 
&EI SAP spool ID 
&EG Confirmation group 
&ES SAP instance name for call-back (if required, otherwise "-") 
&ET Maximum buffer time for call-back events 
&EA Maximum number of buffered events 
&EP Fax recipient (future addition) 
&E1 R/3 flag of LOMS 
&E2 OMS flag of LOMS 
&E3 R/3 flag of ROMS 
&E4 OMS flag of ROMS 
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Baan 
 
For Bann under Unix there should be no problems at all. The Barcodes are 
integrated the standard way, using a shell script (Documentation on request). 
Trigger words for rules are normally found.  
 
For BWPRINT running under MS Windows, the situation could be for Trigger 
Words different. They are maybe not found, as the driver generates the text fully 
graphically. 
 
A client found a way around that, through setting the with parameter in the font 
description to 0. 
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Microsoft Word (also mail merge) 
 
Usually the W-ELP Solution is used in conjunction with Microsoft Word for 
reprinting invoices or fast mail merge printing. In both cases, insert the commands 
using the print field (German Druck).  
 
Insert -> Field -> Search in the right list box for Print/Druck and mark it. Then enter 
the command in the field below like this: 
 
For ELP Commands:  PRINT "<<K3;C1.....>> 
For macros:  PRINT 27"&fs1000y3x1S" 
 
The best way is maybe to save this document as a dot file.  If you have the need to 
change the already defined command, turn the field function to visible at the  
Extras -> Options menu. 
 
Another handicap is stapling mail merge documents, as you can´t staple from this 
function every record.  But in most cases this is the client whish. Using ELP this is 
pretty simply to setup: 
 
1. You need two queues, the QA one you send the data to, the QB one you really 

print. The data will be sent from QA to QB. Please set for both queues the port to 
the printer. 

2. QB needs to have a share name -> use the printer Properties mechanism to setup 
a share name with maximum 8 characters, like ELPEXIT 

3. Activate QA with the ELP printing process. (Install register) 
4. Open the ini-file tab and add a new rule: 

- Add Section, double click on the QA name (close the windows) 
- Mark the section and click on ADD Keys 
- Open the Distribution keys 
- Double click on OutPort 
- change its value for example to: #PCNAME#\ELPEXIT 
- OK 
- Open the Miscellaneous keys 
- Double click on the NoPrintimg key 
- close windows 
- Mark in your new section the new inserted key NoPrinting and turn it on. 

5. Open your mail merge document and insert like described above the following 
print field on the LAST page:  PRINT 27 “)s-997Z”.  
For further information see chapter distributed printing. 

6. Finally print the mail merge document using the mail merge printing function, 
but do not forget to set the printing properties to stapling. 
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Other MS Windows software packages 
 
On any problems that searched or triggered rules for jobs coming from MS 
Windows drivers are not executed please read Q20 in the QA document, which can 
be found in START – Program – Enhance Laser Printing ELP - Manuals! 
 
 
 
 
Other Software packages 
 
If you can’t find a solution in the ELP or Example sections, then please contact the 
support address (PPAdmin ->License Tab ->About) for further help. See last page 
for ways to trigger any ELP functionality. 
 
In any case mostly ELP functions are activated in a way, that no changes need to be 
made at all to the data stream. See page 90 for further details. 
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Localization 
 
The PPAdmin control centre can be localized in any language. The manufacturer is 
more then happy, to receive your localization text, in order to add it to the full 
released product. 
 
Here are the steps to proceed: 
 
1. Tell the PPAdmin software that there is a new language available 

- Open the file LANGUAGE.INI located in the program directory into an 
ASCII Editor, like notepad.  

- Add an new section with a new unique number, e.g.2222. 
- Use the key “name” to teach PPADMIN the name of the new language 
- The key Extension defines a unique file extension for your language, e.g. 

.my 
- Save the file 
- Start PPAmin, and select your new language at the License Register, as the 

result, English will be used as the files are still not translated 
 

2. Turn the PPadmin user interface into your language 
- Open the file 1000.LAN located in the program directory into notepad. 
- Store it to a new file, named with the previous defined new unique number 

and extension “.LAN”, e.g.  2222.lan 
Check if notepad did add the extension .txt. Yes, then rename and reload 
the renamed file into notepad. 

- Now translate the text, every line starts with the text index number, 
followed by a “ and ended with a “. 

- You may store your results any time, start PPAdmin and see the results. 
 

3. You may also translate the PPAdmin keys for the ini-file editor 
- Open the file KEYDATA located the program directory into notepad. 
- Store it to a new file, named also KEYDATA bit add the extension you 

previously defined in the language.ini file, e.g.  KEYDATA.MY 
Check if notepad did add the extension .txt and maybe rename and reload 
the renamed file into notepad. 

- Now translate ONLY the key descriptions 
- You may store your results any time, start PPAdmin, ini-file register, Add 

key, click on the key and see the results. 
 

4. You may also translate the ELP_Training /ELP_Training2222.pdf) and the 
tips.ini (tips.ini.my) files. 
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Demo file descriptions 
 
All provided demo files can be loaded into any ASCII editor, like DOS EDIT or 
Microsoft Word. However, as the file does contain PCL 5e commands, they 
CANNOT be printed out of a windows application. They need to be sent directly 
to the printer or to a printer queue. See the installation chapters for further 
information. 
 
 
Barcode_1D.pcl Prints a huge list of barcode samples 
Barcode_Overview.pcl Prints samples of barcodes and explains how they can 

be setup and configured 
Barcode_2D.pcl Prints a ELP Demo Page of all implemented 2D 

Barcodes 
ELPStatusPage.pcl Prints a ELP Demo Page and gives some information 

about error logging. 
Invoice .pcl Prints en example of how invoices can be duplicate with 

watermarks etc. 
LetterHead.pcl This Demo Page demonstrates how to print 

automatically forms, using ELP command in the data 
stream 

PCL Macro Call.pcl This Demo Page demonstrates how ELP can replace a 
printer Flash DIMM or hard disk for forms and/or font 
management, right away, without any changes to the 
PCL macro commands. 

Trigger.pcl This example demonstrates how to print automatically 
forms, using an ELP command, which is  triggered by 
some information found in the data stream. 

 
In the forms directory several ini-files can be found, they provide examples for: 
 
autoprint.ini Example hoe to print on every printed page the proper 

watermark / company letter head etc. depending upon 
page size and orientation. The forms must be generated 
and are not part of the demo. 

Example.ini.pcl Configuration file for some provided examples. 
Invoice .ini Configuration file for some provided examples. 
MyPrintArchive.ini Configuration file for some provided examples. 
Trigger.ini  Configuration file for some provided examples. 
Volvo.ini  Configuration file for some provided examples. 
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Update  30 
Update the Dimm  16 
UserName  21 
USERNAME  39 

Windows  12, 41 
WorkingDirectory  21, 22 
WorkPath  43 

 
 

 

 
 
Technical support 
 
For questions, inputs, additional support or any other reasons, please contact your 
local distributor. The address can be found in the info box with PPADMIN at the 
license register. 
 
Also you may have a look at: 
 
1. The Question and Answers document located in the Manual section of the 

program start selection: “Enhanced Laser Printing ELP” 
 
2. Chapter examples the administration document 
 
3. If you need personal help, please contact your distributor listed in PPAdmin’s 

license tab -> info box. 
 
 
Thank you for looking and maybe even using our product. 
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